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DRAFT – based on pre-release software Privire de ansamblu

Privire de ansamblu

Acest document descrie cum să creaţi şi să utilizaţi  documentele master în OpenOffice.org 
Writer 2.0.

Copyright şi m rci înregistrateă
Conţinutul acestui document este protejat de Licenţa de Documentaţie Publică, versiunea 1.0 
(numită în continuare Licenţa); aveţi permisiunea de a folosi această documentaţie numai dacă 
sunteţi  de  acord  cu  prevederile  licenţei.  O  copie  a  licenţei  este  disponibilă  la  :
http://www.openoffice.org/licenses/PDL.rtf.

Documentaţia originală a fost scrisă în limba engleză şi este intitulată  Lucrul cu documente
master. Autorul primei versiuni este Jean Hollis Weber © 2005. Toate drepturile rezervate. (îl 
puteţi contacta la: jeanweber@openoffice.org). Contactaţi autorul numai pentru a semnala erori 
în documentaţie. Pentru întrebări despre cum să folosiţi programul, înscrieţi-vă pe lista de mail 
pentru utilizator şi  scrieţi  întrebările  dumneavoastră acolo. Lista de mail  o găsiţi  la adresa 
http://support.openoffice.org/index.html.)

Traducerea în limba română a documentaţiei a fost realizată de Amăriuţei Gheorghe aka ghrt. 
Toate  drepturile  cuvenite  traducătorului  rezervate.  Pentru  eventualele  inadverdenţe  cu 
originalul în limba engleză sau cu programul îmi puteti trimite mail la ghrt@k.ro, sau pe lista 
de discuţii dev@ro.openoffice.org. Vă rog să specificaţi în subiectul mesajului "Introducere în 
stiluri" sau "open office", deoarece primesc foarte mult spam.

Toate mărcile înregistrate aparţin utilizatorilor legitimi.

P rerea dumneavoastră ă
Dacă  doriţi  să  faceţi  comentarii  sau  sugestii  despre  acest  document  vă  rog  să  scrieţi  la 
authors@user-faq.openoffice.org. Pentru  versiunea  în  limba  română,  adresa  este 
dev@ro.openoffice.org.

Mul umiriţ
Mare  parte  din  acest  capitol  este  bazat  pe  materialul  publicat  prima  dată  în  Taming 
OpenOffice.org Writer 1.1, de Jean Hollis Weber, © 2003. Mulţumiri lui Ian Laurenson pentru 
corecturi.
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Modific ri şi actualiz riă ă

Versiune Data Descrierea modific riiă

1.0 24 January 
2005

First published edition.

1 Martie 2005 Tradus în limba română
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CIORN  - bazat  pe software nefinalizatĂ ă De ce s  folosim un documentă
master?

De ce s  folosim un document master?ă

Documentele master sunt de obicei folosite la scrierea unor documente lungi, ca de exemplu o 
carte, o teză, sau un lung raport. Un document master este în mod special util când imaginile, 
foile  de  calcul,  sau  alte  obiecte  determină o mărime apreciabilă  a  fişierului  ce  stochează 
lucrarea. Documentele master mai sunt folosite şi când la secţiunile unui document se lucrează 
de către oameni diferiţi, astfel încât ei nu vor avea nevoie să facă schimburi de fişiere. Un 
document master alătură documente text separate într-un document mare, unificând formatarea, 
cuprinsul (ToC - table of contents), bibliografia, şi alte tabele sau liste.

Documentele master sunt aşadar utile - pe de altă parte,  sunt şi funcţionale în OOoWriter. 
Totuşi, utilizarea lor este plină de capcane pentru începători. Astfel că, până depăşiţi statutul de 
începător - învăţând aceste capcane şi cum să le evitaţi, s-ar putea să credeţi că documentele 
master sunt instabile sau dificil de folosit.

Puteţi folosi mai multe metode pentru a crea documente master. Fiecare metodă are avantajele 
şi dezavantajele ei. Metoda va fi aleasă în funcţie de ceea ce vreţi să faceţi. Acest document 
descrie metodele existente, împreună cu sugestiile de utilizare pentru fiecare.

Stiluri şi documentele master

The following note is based on information in the help files.

Stilurile  care sunt folosite în subdocumente,  cum sunt stilurile  de paragraf,  sunt importate 
automat în documentul master după ce salvaţi documentul master. Când modificaţi stilul din 
documentul master, stilul din subdocument rămâne neafectat. Aceasta înseamnă că stilul din 
documentul master este folosit în locul stilului din subdocument.

Notă Folosiţi  acelaşi  şablon  (document  template)  pentru  documentul  master  şi 
subdocumentele care  îl  compun. Când modificaţi  sau  creaţi  un stil,  adăugaţi-l  la 
şablon, şi apoi reîncărcaţi documentul master pentru a-l aplica şi subdocumentelor. În 
acest fel subdocumentele vor arăta la fel când vor fi încărcate în documentul master, 
exceptând stilurile de pagină şi cele aplicate direct paragrafelor în scopul restartării 
(sau modificării) numerotării paginilor.

Folosind Navigatorul

Navigatorul este o unealtă foarte folositoare care vă ajută să vă deplasaţi rapid în diferite părţi 
ale  documentului.  De  asemenea,  puteti  vedea  conţinutul  documentului  şi  va  ajuta  să 
reorganizaţi o parte din acesta. De exemplu,  dacă aţi scris separat câte un document pentru 
fiecare capitol al cărţii, în documentul master acestea pot fi rearanjate, referinţele fiind automat 
renumerotate, iar cuprinsul actualizat.

În  Writer,  Navigatorul  are  două  forme  distincte.  Una  este  folosită  în  documentele  text 
obişnuite, iar cealaltă în documente master. 
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CIORN  - bazat  pe software nefinalizatĂ ă Folosind Navigatorul

Într-un  document  text  obişnuit,  Navigatorul  afişează  listele  imaginilor,  tabelelor,  intrărilor 
pentru index, hiperlegăturilor, referinţelor, şi altor obiecte din document, după cum se vede în 
Imaginea 1. Daţi clic pe semnul + de lângă oricare listă şi va fi afişat continutul acesteia. Puteţi 
da dublu - clic pe un element din lista şi veţi sări imediat la acel obiect din document. Pentru 
detalii, citiţi capitolul “Working with Writer” din Ghidul OOo Writer-ului.

Imaginea 1. Navigatorul în cazul unui document text.

Într-un document master, Navigatorul listează subdocumentele şi secţiunile text, după cum se 
vede în Imaginea 2. Utilizarea Navigatorului într-un document master este discutată mai jos în 
acest capitol.

Imaginea 2. Navigatorul pentru un document master
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Crearea unui document master

Cele  trei  modalităţi  de  creare  a  unui  document  master  depind  de  stadiul  în  care  se  află 
documentul dumneavoastră:

• Aveţi  un  document  (o  carte)  pe  care  doriţi  să  o  divizaţi  în  câteva  subdocumente 
(capitole) care vor fi controlate de un document master.

• Aveţi câteva documente (capitole) pe care doriţi să le combinaţi într-o carte care va fi 
controlată de un document master.

• Nu aveţi nici un document dar doriţi să scrieţi o carte destul de lungă împărţită în câteva 
capitole.

Vom trata pe rând fiecare modalitate.

Divizarea unui document într-un document master şi 
subdocumente
Când aveţi deja un document pe care doriţi să îl divizaţi în câteva subdocumente care vor fi 
controlate de un document master, puteţi face această divizare în mod automat.

Când să folosiţi această metodă: Dacă documentul original foloseşte numai stilul de pagină 
Obişnuit  (Default),  este  numerotat  crescător  începând  cu  prima  pagină,  şi  foloseşte  stilul 
"Heading  1"  pentru  a  identifica  începutul  fiecărui  capitol;  dacă  toate  aceste  condiţii  sunt 
îndeplinite, această metodă va funcţiona bine.

Avantaje: Această metodă este uşoară şi rapidă, iar referinţele existente între capitole vor fi 
păstrate. Deşi s-ar putea să mai trebuiască să corectaţi câte ceva, acest lucru nu va fi necesar 
decât o singură dată.

Dezavantaje: Dacă documentul original era complex, s-ar putea să aveţi destul de mult de 
muncă deoarece elemente referitoare la formatare vor fi pierdute — de exemplu, stilurile de 
pagină, întreruperile de pagină, restartarea numerotării.

Cum se face: Deschideţi documentul şi alegeţi Fişier > Trimite > Crează document master 
(File > Send > Create master document) pentru a diviza documentul. Veţi observa că fiecare 
subdocument  începe  cu  stilul  "Heading  1"  şi  numele  fişierelor  sunt  de  forma 
"nume_doc_anteriorX.odt" (“maindocnameX.odt”),  unde X este  1,  2,  3 şi  aşa mai  departe. 
Dacă aveţi un capitol care începe cu stilul "Heading 1" înainte de capitolul nr. 1 (de exemplu 
pe  post  de  prefaţă),  atunci  numerele  din  denumirea  fişierelor  nu  vor  mai  corespunde  cu 
numerele capitolelor.

Combinarea  câtorva  documente  într-un  document 
master
Această  metodă  merge  cel  mai  bine  atunci  când toate  documente  au  fost  create  pe  baza 
aceluiaşi şablon, dar totuşi va funcţiona şi când aţi folosit şabloane diferite.
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CIORN  - bazat  pe software nefinalizatĂ ă Crearea unui document master

Folosiţi  unul  dintre procedeele  descrise în  Use one of the techniques described in “Când 
începeţi de la zero” pentru a crea un document master fără conţinut şi a insera documentele ca 
subdocumente în documentul master.

Când începe i de la zeroţ
Situaţia ideală este să folosiţi de la început documentul master, deoarece veţi putea face totul 
corect de la bun început. Writer oferă trei modalităţi de a crea un document master:

• Metoda 1. Uşor şi repede, dar nerecomandat

• Metoda 2. Nu prea complicată, dar cu restricţii

• Metoda 3. Control complet

În  fiecare  caz,  va  trebui  să  lucraţi  disciplinat  pentru  a  fi  sigur  că  documentul  master 
funcţionează corect şi sigur. Fiecare metodă de mai jos descrie paşii necesari. Fiţi atent să îi 
executaţi în ordinea indicată.

Metoda 1. Uşor şi repede, dar nerecomandat

Writer oferă o metodă uşoară şi rapidă de a crea un document master, dar documentul master 
nu este asociat cu un şablon, astfel încât modificările stilurilor şi al formatărilor sunt mai dificil 
de făcut în condiţii de siguranţă. Cum să faceţi aceasta: 

1) Alegeţi Fişier > Nou > Document master (File > New > Master Document).

2) Folsiţi Navigatorul pentru a insera noi documente sau fişiere existente în documentul 
master,  după  cum este  descris  în  “Pasul  5.  Inseraţi  subdocumentele  în  documentul
master” la pagina 10.

Metoda 2. Nu prea complicat , dar cu restric iiă ţ
Această metodă va funcţiona dacă doriţi să numerotaţi paginile crescator de la începutul şi până 
la  sfârşitul  documentului  final,  fără  a  putea  ca  la  o  pagină  să  puteţi  stabili  reînceperea 
numerotării, iar fiecare capitol va începe cu stilul "Heading 1" pe fiecare pagină. Dacă aveţi 
nevoie de modificări asupra numerotării în cadrul documentului, folosiţi metoda 3.

Cum procedaţi: Urmaţi instrucţiunile din următoarea secţiune (Metoda 3. Control complet), dar 
nu  inseraţi  secţiuni  (de  text)  între   subdocumente  şi  nu  încercaţi  să  alteraţi  numerotarea 
paginilor.

Metoda 3. Control complet

Această  metodă  va  oferă  control  complet  asupra  documentelor  complexe  cu  diverse  (mai 
multe) stiluri de pagină sau pe parcursul cărora este alterată numerotarea paginilor. Este ceva 
mai mult de muncă pentru a pune la punct un astfel de document, dar va funcţiona în general 
foarte bine.1

Cum procedaţi: Urmaţi paşii următori, în ordinea indicată.

Pasul 1. Planificaţi proiectul

1 Cu toate acestea, sunt şi situaţii în care această metodă nu va funcţiona. Citiţi secţiunile referitoare la Rezolvarea 
problemelor pentru detalii.
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CIORN  - bazat  pe software nefinalizatĂ ă Crearea unui document master

Pasul 2. Crearea unui şablon cuprinzând stilurile, câmpurile şi alte elemente

Pasul 3. Creaţi documentul master şi subdocumentele pe baza aceluiaşi şablon

Pasul 4. Inseraţi direct în documentul master

Pasul 5. Inseraţi subdocumentele în documentul master

Pasul 6. Adăugarea cuprinsului, bibliografiei şi indexului

Pasul 1. Planifica i proiectulţ
Deşi  puteţi  efectua oricând modificări,  cu cât  anticipaţi  mai  mult  cu atât  veţi  fi  scutit  de 
probleme mai târziu. Iată câteva lucruri la care să vă gândiţi:

● Părţile cărţii (sau raportului ori ce aveţi de făcut) necesare, şi numerotarea care va fi folosită 
pentru fiecare. Vom folosi ca exemplu o carte cu aceste părţi:

Pagina de titlu (copertă) 1 pagină fără număr de pagină
Pagina pentru copyright 1 pagină (verso pagina de titlu) fără număr de pagină
Cuprinsul lungime necunoscută începe cu 'i'
Prefaţa (Prolog) 2 pagini continuă de la Cuprins
Capitolele 1 ... 8 lungime necunoscută începe de la 1
Anexele A, B lungime necunoscută continuă de la Capitolul 8
Indexul lungime necunoscută continuă de la Anexa B

● Paginile care vor fi în documentul master şi cele care vor fi în subdocumente. Cuprinsul şi 
indexul trebuie să fie în documentul master. Un aranjament tipic este astfel:

Pagina de titlu (copertă) În documentul master
Pagina pentru copyright În documentul master
Cuprinsul În documentul master
Prefaţa (Prolog) Subdocument
Capitolele 1 ... 8 Subdocumente
Anexele A, B Subdocumente
Indexul În documentul master

● Stilurile  de  pagină,  paragraf,  caracter,  cadru  (frame),  şi  numerotare.  (Pentru  crearea  şi 
modificarea stilurilor citiţi capitolul respectiv din Ghidul utilizator.) Câteva stiluri pe care le 
vom folosi în cartea cu care exemplificăm sunt:

Stilurile de pagină

Nume Caracteristici Următorul  stil  de 
pagină

Pagina  de  titlu 
(copertă)

Fără început şi sfârşit de pagină sau 
numere de pagină; aspect diferit faţă 
de celelalte pagini

Pagina pentru copyright

Pagina  pentru 
copyright

Fără început şi sfârşit de pagină sau 
numere de pagină; aspect diferit faţă 
de celelalte pagini

Prima pagină din prefaţă 
(prolog)

Prima  pagină  din 
prefaţă (prolog)

Fără  început  de  pagină;  numărul 
paginii  la  sfârşitul  paginii,  cu  cifre 

Prima pagină din prefaţă 
(prolog), stânga
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Nume Caracteristici Următorul  stil  de 
pagină

romane (i, ii,  iii);  aspect diferit faţă 
de paginile următoare

Prima  pagină  din 
prefaţă  (prolog), 
stânga

Început  şi  sfârşit  de  pagină,  unul 
conţinând  numărul  paginii  (cifre 
romane)

Prima pagină din prefaţă 
(prolog), dreapta

Prima  pagină  din 
prefaţă  (prolog), 
dreapta

Marginile  în  oglindă  faţă  de  prima 
pagină  din  prefaţă  (prolog),  stânga; 
numere de pagină cu cifre romane

Prima pagină din prefaţă 
(prolog), stânga

Prima pagină Fără  început  de  pagină;  numărul 
paginii  la  sfârşitul  paginii,  cu  cifre 
arabe;  aspectul  similar  cu  cel  al 
prima pagină din prefaţă (prolog)

Pagină, stânga

Pagină, stânga Aspectul  similar  cu  cel  al  prima 
pagină  din  prefaţă  (prolog),  stânga, 
dar  cu  cifre  arabe  pentru  numerele 
paginilor

Pagină, dreapta

Pagină, dreapta Aspectul  similar  cu  cel  al  prima 
pagină din prefaţă (prolog), dreapta, 
dar  cu  cifre  arabe  pentru  numerele 
paginilor

Pagină, stânga

Stilurile de paragraf

Folosiţi  stilul  "Heading 1" pentru titlurile  de capitol.  Dacă este  necesar,  definiţi  un stil 
pentru titlurile Anexelor. Un stil la îndemână este "Page Break", definit ca mărimea 6 pt, 
fără spaţii înainte sau după, întrerupere de pagină înainte. Folosiţi orice alt stil de paragraf vi 
se potriveşte.

● Inseraţi Câmpuri (Fields) şi intrări AutoText după cum este necesar. Citiţi şi restul Ghidului 
pentru a avea o viziune completă.

Pasul  2.  Crearea  unui  şablon  cuprinzând  stilurile,  câmpurile  şi  alte 
elemente

Puteţi crea propriul şablon dintr-un document existent sau şablon care conţine toate sau o parte 
din stilurile de care aveţi nevoie, sau puteţi crea şablonul începând cu un document vid. Pentru 
mai multe informaţii despre şabloane, citiţi capitolul “Lucrul cu şabloane” din Ghidul Writer.

Dacă  folosiţi  un  şablon sau  un  document  deja  existent,  înailte  de  a-l  salva  ca  şablon vă 
recomand să ştergeţi tot textul din el în afară de câmpuri, începuturi şi sfârşituri de pagină. 
Stilurile pe care le-aţi definit vor rămâne, chiar dacă nu mai este şi textul.

Pentru a salva şablonul folosiţi Fişier > Şabloane > Salvează (File > Templates > Save). Veţi 
putea schimba stilurile din şablon pe măsură ce vă dezvoltaţi lucrarea.
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Pasul 3. Crea i documentul master şi subdocumentele pe baza aceluiaşiţ  
şablon

Dacă demaraţi un proiect nou, trebuie să vă asiguraţi că veţi crea documentul master şi toate 
subdocumente pe baza aceluiaşi şablon. Nu contează ordinea în care le creaţi, nici nu trebuie să 
le creaţi în acelaşi timp, la începerea proiectului. Puteţi adăuga noi subdocumente oricând, pe 
măsură ce aveţi nevoie de ele — atâta timp cât le creaţi pe baza aceluiaşi şablon.

Crearea documentului master
Vă recomand să urmaţi paşii de mai jos pentru a crea documentul master. Puteţi folosi şi alte 
metode, dar fiecare metodă (inclusiv aceasta) are şi dezavantajele ei.

1) Deschideţi un document nou pe baza şablonului pe care l-aţi creat la Pasul 2. Asiguraţi-
vă că primei pagini a acestui document nou i s-a aplicat stilul de pagină pe care îl doriţi 
pentru  prima pagină  a  documentului  final.  În  exemplul  nostru,  stilul  pentru  prima 
pagină este "Pagina de titlu (copertă)" ("Title Page").

2) Dacă din şablon s-au preluat în acest document text sau vreo întrerupere de pagină, 
ştergeţi textul. (Câmpurile din capetele şi finalurile de pagină pot să rămână.) 

3) Alegeţi  Fişier > Trimite > Crează document master (File > Send > Create master 
document). Savaţi documentul master în directorul destinat acestui proiect, nu în cel 
pentru şabloane. Ne vom întoarce la acest document master mai târziu. Acum, îl puteţi 
lăsa deschis sau închide, după cum preferaţi.

Crearea subdocumentelor
Un subdocument nu este în nici un fel diferit de alte documente text. Se numeşte subdocument 
numai pentru că la un moment dat va fi legat într-un document master şi va fi deschis din 
documentul  master.  Unele setări  din documentul  master vor lua precedenţă faţă de setările 
similare din subdocument, dar numai atunci când documentul este vizualizat, manipulat sau 
tipărit prin documentul master.

Creaţi un subdocument similar cu un document ordinar (cu excepţia şablonului):

1) Deschideţi un document gol pe baza şablonului folosit special pentru acest proiect.

2) Ştergeţi textul inutil, şi stabiliţi stilul primei pagini ca fiind stilul pentru prima pagină a 
unui capitol.

3) Apăsaţi Fişier > Salvează ca (File > Save As). Denumiţi documentul corespunzător şi 
salvaţi-l în directorul ales pentru acest proiect.

Dacă  deja  aţi  scris  unul  sau  mai  multe  capitole  şi  acestea  nu  sunt  bazate  pe  şablonul 
proiectului,  va trebui  să schimbaţi  şablonul  documentelor respective.  Singura modalitate în 
care puteţi face aceasta este:

1) Deschideţi un document gol pe baza şablonului de proiect.

2) Copiaţi conţinutul documentului deja scris în acest nou document.

3) Alegeţi  Fişier > Salvează ca  (File > Save As) şi salvaţi noul document în directorul 
proiectul cu un nume corespunzător.

4) Redenumiţi fişierul original astfel încât să ştiţi că l-aţi convertit.
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Pasul 4. Insera i direct în documentul masterţ
Instrucţiunile de la paşii 4 şi 5 sunt date conform cu numerotarea paginilor de la pasul 1. Dacă 
proiectul  dumneavoastră  va  avea  alte  cerinţe  de  numerotare  va  trebui  să  adaptaţi  cele  ce 
urmează.2

Aceste instrucţiuni vi se pot părea plictisitoare, dar după ce aţi creat documentul master nu va 
trebui să îl mai modificaţi, şi cu puţină experienţă setarea va începe să mearga repede.

1) Deschideţi documentul master şi faceţi astfel:

• Asiguraţi-vă că sunt afişate sfârşiturile de paragraf (aceasta o stabiliţi în  Unelte > 
Opţiuni > OpenOffice.org Writer > Auxiliarele formatării - Tools > Options > 
OpenOffice.org  Writer  >  Formatting  Aids,  sau  daţi  click  pe  butonul  grafic 

Caractere neimprimabile - Nonprinting characters ).

• Vizualizaţi  marginile  textului,  tabelelor  şi  secţiunilor  (Unelte  >  Opţiuni  > 
OpenOffice.org > Aspect - Tools > Options > OpenOffice.org > Appearance). 

2) Tastaţi conţinutul paginii de titlu (sau tastaţi nişte caractere şi scrieţi mai târziu textul 
final). Având cursorul situat în ultimul paragraf gol de pe pagină, alegeţi  Inserare > 
Întrerupere  manuală  (Insert  >  Manual  Break).  Din  caseta  de  dialog  Inserare 
întrerupere (Insert Break) (Imaginea 3), selectaţi  Întrerupere pagină (Page break) şi 
stilul  pentru  a  doua  pagină  (în  exemplul  nostru  era  pagina  de  copyright),  şi  lăsaţi 
debifată căsuţa Schimbă numărul paginii (Change page number). Apăsaţi OK.

Imaginea 3. Inserarea unei întreruperi de pagină între pagina de titlu (copertă) şi cea de 
copyright.

3) Tastaţi conţinutul paginii de copyright (sau ceva care să-i ţină temporar locul). Inseraţi 
altă întrerupere manuală a paginii, stabilind stilul celei de a treia pagini ca fiind "Prima 
pagină din prefaţă (prolog)" (Front matter first page). Bifaţi căsuţa Schimbă numărul 
paginii (Change page number) şi tastaţi '1' în cmpul de dedesupt, după cum se vede în 
Imaginea 4. Acest număr '1' va fi afişat în documentul dumneavoastră ca 'i', deoarece la 
stilul paginii am stabilit să folosim numere romane.

2 Consultaţi secţiunea referitoare la Rezolvarea problemelor pentru un exemplu.
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Imaginea 4. Inserarea unei întreruperi de pagină înaintea primei pagini din prefaţă  
(prolog).

4) Să presupunem că a treia pagină este pentru Cuprins. Lăsaţi pe această pagină unul sau 
două paragrafe  goale  şi  inseraţi  o altă  întrerupere  de pagină,  cu următoarea pagină 
folosind stilul "Prima pagină din prefaţă (prolog)" (Front matter first page). Deoarece 
dorim ca numerotarea paginilor Prefeţei  să continue de la Cuprins, nu vom mai bifa 
căsuţa  Schimbă numărul paginii  (Change page number). Observaţi că Navigatorul 
arată un element, numit Text.

Lucrul cu documente master 9



CIORN  - bazat  pe software nefinalizatĂ ă Crearea unui document master

Pasul 5. Insera i subdocumentele în documentul masterţ
În sfârşit suntem gata să adăugăm primul subdocument, care în acest exemplu este Prefaţa. 

1) Deschideţi Navigatorul (apăsaţi Edit(are) > Navigator, sau apăsaţi F5, sau daţi clic pe 
butonul Navigator  .

2) Din Navigator, selectaţi  Text,  apoi apăsaţi  lung pe butonul  Inserează  (Insert) (este 
apăsat în Imaginea 5) şi selectaţi Fişier (File).

Imaginea 5. Inserarea unui subdocument într-un document master folosind Navigatorul.

Va apare o casetă obişnuită de dialog pentru deschiderea fişierelor (File Open). Selectaţi 
fişierul (creat la pasul 3) şi apăsaţi OK. Aşteptaţi ca OOoWriter să încarce documentul.

Veţi  vedea că fişierul  inserat  este  afişat  de Navigator  înaintea elementului  Text,  în 
Imaginea 6. 

Imaginea 6. Navigatorul după inserţia unui subdocument.

3) Repetaţi până când toate subdocumentele au fost adăugate în listă. Navigatorul va arăta 
aproximativ ca în Imaginea 7.
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Imaginea 7. Navigatorul afişează fişierele din documentul master.

4) Salvaţi documentul master din nou. Acum selectaţi pe rând fiecare capitol şi inseraţi o 
secţiune Text înaintea fiecăruia. Când aţi terminat, Navigatorul va arata ca în Imaginea
8.

Imaginea 8. Navigatorul afişează o serie fişiere şi secţiuni text.

PONT Puteţi  defini  ca  stilul  de  paragraf  "Heading  1"  sa  fie  primul  pe  prima pagină  a 
capitolului  şi  astfel  veţi  fi  scutit  de  a  insera  întreruperi  manuale  de  pagină între 
capitole, dar veţi avea probleme dacă veţi dori să alterati numerotarea paginilor la 
începutul primului capitol.

Aceasta  datorită  faptului  că  pentru a  restarta  numerotarea  paginilor,  va  trebui  să 
inseraţi o întrerupere de pagină manuală; însă stilul "Heading 1" prezent pe prima 
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pagină a primului capitol va genera o întrerupere automată de pagină, şi veţi avea cel 
puţin o pagină albă, nedorită, înaintea primului capitol. Tehnica descrisă aici previne 
această problemă.

5) Verificaţi dacă prima pagină din documentul master are aplicat stilul corect de pagină. 
Dacă nu, aplicaţi-l (Pagina de titlu (copertă) - Title page în exemplul nostru).

Derulaţi până la începutul  primului  subdocument. Verificaţi  că stilul  paginii este cel 
corect, şi schimbaţi-l dacă nu este (Prima pagină din prefaţă (prolog) - Front matter 
first page în exemplul nostru).

Veţi  observa că primul  subdocument  (Imaginea 9)  are  un paragraf  gol  la  începutul 
paginii; acesta a fost inserat ca parte a întreruperii manuale de pagină. Aplicaţi acestui 
paragraf stilul PageBreak creat la pasul 2 (vedeţi şi Stilurile de paragraf de la pasul 1). 

Paragraph marker Section marker

Protected section 
containing 
subdocument

Imaginea 9. Întrerupere de pagină înaintea subdocumentului, care este într-o zonă protejată.

6) Veţi mai observa că documentul este într-o zonă protejată. Aceasta înseamnă că nu veţi 
putea  modifica  nimic  din  conţinutul  subdocumentului  cât  timp  sunteţi  în  cadrul 
documentului master. (Dacă ştergeţi o secţiune, conţinutul devine parte a documentului 
master  însuşi;  nu mai  sunt  într-un  subdocument.  Pentru  mai  multe  despre  secţiuni, 
căutaţi în ajutorul integrat sau citiţi capitolul Lucrul cu secţiuni din Ghidul Writer.)

Derulaţi în jos până ajungeţi la începutul primului capitol. Veţi găsi că este pe aceeaşi 
pagină ca şi  sfârşitul  Prefeţei,  şi  că există  un paragraf  gol  între  cele  două  secţiuni 
(prefaţa şi primul capitol), după cum se vede în Imaginea 10.

Daţi clic pe acest paragraf şi inseraţi o întrerupere de pagină, specificând Prima pagină 
ca stil de pagină şi alegeţi numerotarea paginilor să reînceapă de la 1. Apăsaţi OK.
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Section marker at 
start of next section

Section marker at end 
of previous section

Text area in master document, between sections

Imaginea 10. O zonă de text între două secţiuni din documentul master.

7) Derulaţi până la prima pagină din capitolul 2. Veţi observa ca este pe aceeaşi pagină cu 
finalul  capitolului  1,  şi  că există  un paragraf  gol  în  zona de  text  dintre  cele  două 
capitole.

Daţi clic pe acest paragraf şi inseraţi o întrerupere de pagină, specificând Prima pagină 
ca stil de pagină, dar nu alteraţi numerotarea paginilor.

Repetaţi pentru toate capitolele, astfel încât fiecare capitol să înceapă pe o pagină nouă.

8) Savaţi documentul master din nou.

Pasul 6. Ad ugarea cuprinsului, bibliografiei şi indexuluiă
Puteţi genera cuprins, bibliografie sau index pentru carte, folosind documentul master. Trebuie 
să inseraţi aceste elemente într-o secţiune text din documentul master.

Mutaţi cursorul unde veţi dori să inserati Cuprinsul (aceasta va fi totuşi pe pagina rezervata 
acestuia când am planificat structura cărţii). Creaţi cuprinsul conform descrierii din capitolul 
intitulat “Crearea şi menţinerea cuprinsului, indecşilor şi bibliografiilor” din Ghidul Writer.

Dacă nu există o secţiune Text la sfârşitul documentului master, inseraţi una înaintea ultimului 
subdocument, apoi mutaţi-o în jos, după finalul ultimului subdocument. Acum, dacă aţi inclus 
referinţe  bibliografice  în subdocumente,  mutaţi  cursorul  în această ultimă secţiune de  text 
(locul obişnuit pentru bibliografie). Acum puteţi să creaţi bibliografia.

Dacă aţi inclus indecşi în subdocumente, mutaţi cursorul unde veţi insera indexul (daca este 
necesar procedaţi ca pentru bibliografie) şi creaţi indexul.
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Editarea unui document master

După  crearea  unui  document  master,  probabil  că  veţi  dori  să-i  schimbaţi  aspectul  sau 
conţinutul.

Schimbarea aspectului documentului
Puteţi schimba stilurile din şablon pe măsură ce dezvoltaţi proiectul. Nu schimbaţi stilurile în 
documentul master sau în vreun subdocument—schimbaţi-le în şablon.

Pentru a actualiza documentul master (şi toate subdocumentele) faţă de şablon, pur şi simplu 
deschideţi documentul master. Veţi primi două mesaje: primul, o întrebare dacă doriţi să fie 
actualizate toate legăturile; şi a doua, dacă doriţi să aplicaţi schimbările de stiluri. Răspundeţi 
afirmativ la ambele întrebări.

Editarea subdocumentelor
Nu puteţi  edita un subdocument din cadrul documentului master. Pentru aceasta, trebuie să 
deschideţi subdocumentul, fie prin dublu clic pe el în Navigatorul din documentul master, fie 
deschizândul din afara documentului master, ca pe un document obişnuit. Apoi îl puteţi edita 
ca pe un document obişnuit. Există însă o regulă: dacă modificaţi stilurile în subdocument, va 
trebui să copiaţi acele stiluri în şablon astfel încât să fie folosite în toate subdocumentele şi în 
documentul master.

Dacă schimbaţi conţinutul oricărui subdocument, va trebui să actualizaţi (manual) cuprinsul, 
bibliografia şi indexul în cadrul documentului master.

Referin e între subdocumenteţ

Metodele  descrise  mai  devreme în  acest  capitol  sunt  suficiente  pentru  nevoile  majorităţii 
utilizatorilor de documente master. Totuşi, în unele documente master este imperativ nevoie de 
actualizarea  automată  a  referinţelor  între  subdocumente.  Această  secţiune  descrie  cum să 
realizaţi aceasta.

Procesul creării referinţelor între subdocumente este plictisitor dar funcţional. (O alternativă 
este  să  folosiţi  macroul  creat  de  Ian  Laurenson,  OutlineCrossRef  macro,  disponibil  la 
http://oooauthors.org/groups/members/macros/macros4ooo/writer/references/OutlineCrossRef-
v3.1.sxw.)

1) În primul rând stabiliţi ce veţi referi în fiecare subdocument, la fel ca atunci când faceţi 
referinţe în cadrul  aceluiaşi  document.  Când faceţi  aceasta,  notaţi  pe o listă numele 
fiecărui câmp pe care îl definiţi, şi asiguraţi-vă că aceste nume sunt unice.

Numele câmpurilor fac diferenţă între majuscule şi minuscule. Puteţi verifica numele 
câmpului  ţinând cursorul  mausului  deasupra  elementului  referit.  În exemplul  nostru 
(Imaginea 11), câmpul asociat titlului a fost denumit word count.
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Imaginea 11. Aflarea numelui câmpului.

2) Deschideţi documentul master. În Navigator (Imaginea 12), selectaţi un subdocument şi 
daţi  clic pe butonul  Edit(are) (sau daţi  clic dreapta şi  alegeţi  Edit(are)  din meniul 
contextual). Subdocumentul este deschis pentru editare.

Imaginea 12. Selectarea unui subdocument în Navigator.

3) În subdocument, plasaţi cursorul unde doriţi să inseraţi referinţa. Alegeţi  Inserează > 
Referinţă (Insert > Cross Reference).

4) În  caseta  de  dialog  Câmpuri  (Fields),  pe  pagina  Referinţe  (References),  selectaţi 
Inserare referinţă (Insert Reference) în lista Tip (Type) din partea stângă (Imaginea
13). Lista Selecţie (Selection) din coloana din mijloc arată numai numele câmpurilor 
pentru referinţele  din subdocumentul  curent,  aşa că uitaţi  de această listă şi  folosiţi 
propria dumneavoastră listă, creată anterior la pasul 1.

5) În câmpul  Nume  (Name) din  coloana  din  partea  dreaptă,  tastaţi  numele  câmpului 
referinţei pe care aţi creat-o în subdocumentul la care vreţi să vă referiţi. În exemplul 
nostru, referinţa este în capitolul 3, iar numele ei este word count.
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Imaginea 13. Caseta de dialog Câmpuri (Fields), numele câmpului fiind introdus manual.

6) Apăsaţi  Inserare  (Insert). Singurul lucru care va apărea în subdocument este o mica 
zonă gri care indică prezenţa unui câmp. Dacă ţineţi mausul deasupra acestei zone, veţi 
afla numele câmpului (Imaginea 14). 

Imaginea 14. Vizualizarea numelui câmpului.

(Puteţi activa afişarea numelor câmpurilor alegând Unelte > Opţiuni > Document text 
> Vizualizare  (Tools > Options > Text Document > View) şi bifând căsuţa  Nume 
câmpuri  (Field Codes). Dacă faceţi (sau aţi făcut) aceasta, cele două câmpuri gri din 
Imaginea 14 vor arăta ca în Imaginea 15.)

Imaginea 15. Afişarea numelor de câmpuri.
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7) După ce aţi inserat toate referinţele necesare în subdocument, salvaţi-l,  închideţi-l şi 
reveniţi la documentul master.

În cadrul documentului master, deplasaţi-vă la pagina subdocumentui unde aţi inserat 
câmpul  referinţei.  Acum  ar  trebui  să  vedeţi  textul  referinţei  apărând  la  locul 
inserţiei(Imaginea 15), deoarece în cadrul documentului master, subdocumentul poate 
găsi ţinta acelei referinţe.

Imaginea 16. Conţinutul câmpului arată pagina din fişier.

Această tehnică funcţionează şi atunci când deschideţi un subdocument direct la pasul 2 (adică, 
din cadrul documentului master) şi inseraţi un câmp pentru referinţă.

Lucrul cu documente master 17



CIORN  - bazat  pe software nefinalizatĂ ă Rezolvarea problemelor

Rezolvarea problemelor

Unele combinaţii ale opţiunilor nu funcţionează. Această secţiune descrie unele probleme şi 
oferă nişte soluţii.

Includrea  unei  referin e  la  un  capitol  în  capul  deţ  
pagin  (header) al primei paginiă

Problema

Dacă folosiţi metoda descrisă în “Pasul 5. Inseraţi subdocumentele în documentul master” de 
pe pagina 10 (inserarea unei întreruperi de pagină în documentul master între subdocumente), 
şi inseraţi o referinţă la numele şi numărul capitolului în capul de pagină al  primei pagini a 
fiecărui capitol,  atunci câmpul  referintei  de pe prima pagină va furniza numele şi  numărul 
capitolului anterior. Aceasta se petrece deoarece cu metoda descrisă primul paragraf (gol) de 
pe acele pagini este de fapt ultimul paragraf din capitolul anterior. Exemplul meu nu a inclus o 
referinţă la numele şi  numărul capitolului  în capul de pagină al primei  pagini,  astfel  încqt 
această problema nu a apărut.

Finalul de pagină al primei pagini nu prezintă această problemă; el furnizează corect numele 
şi numărul capitolului.

Solu iaţ
Soluţia pentru această problemă este următoarea:

1) Folosiţi  Fisier > Şabloane > Editare  (File > Templates > Edit) pentru a deschide 
şablonul folosit pentru documentul master şi subdocumente.

2) Modificaţi stilul pentru titlul capitolului (de obicei este "Heading 1") pentru a genera o 
întrerupere de pagină înainte, folosind stilul  de pagină pe care îl  doriţi  pentru prima 
pagină a fiecărui capitol. Salvaţi şi închideţi şablonul.

3) Când redeschideţi documentul master, vă vor fi puse două întrebări: "Actualizez toate 
legăturile?" (“Update all links?”) şi "Stilurile dumneavoastră nu se potrivesc cu cele din 
şablon. Doriţi să actualizez fişierele?" (“Your styles don’t match the template. Do you 
want to update your files?”). Răspundeţi afirmativ la ambele întrebări.

4) Modificaţi stilul  titlului  de capitol (Heading 1) din documentul master aşa cum l-aţi 
modificat şi în şablon la pasul 2. Salvaţi documentul master.

5) Deschideţi  Navigatorul  în  documentul  master,  vizualizaţi  şi  ştergeţi  secţiunile  Text 
dintre capitole. Actualizaţi toate legăturile.

Capetele de pagină de pe prima pagină a fiecărui  capitol  vor afişa acum corect numele şi 
numărul capitolului.
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Solu ia creaz  o alt  problem  - şi cum evita i aceast  problemţ ă ă ă ţ ă ă
Această soluţie crează o altă problemă, dacă doriţi să restartaţi numerotarea paginilor de la "1" 
pe prima pagină a  primului  capitol  şi aveţi  paginile  numerotate  crescător de  la  primul  la 
ultimul capitol.

În  mod  normal  veţi  dori  să  restartaţi  numerotarea  specificând  numărul  de  început  când 
modificaţi stilul "Heading 1" la începutul unei noi pagini. Totuşi, dacă veţi proceda aşa, prima 
pagină a fiecărui capitol va începe de la "1". (Uneori asta şi doriţi, dar de obicei nu este cazul.)

În acest caz, va trebui să includeţi o compensaţie în câmpul numărului de pagină—adică, să-i 
spuneţi lui OOoWriter câte pagini să scadă pentru ca prima pagină a primului capitol sa fie 
pagina "1". Desigur, pentru ca aceasta să meargă, trebuie să ştiţi  câte pagini are prefaţa (şi 
cuprinsul daca este cazul, etc), şi s-ar putea să nu ştiţi până când nu veţi finaliza cartea. Dacă 
adăugaţi sau ştergeţi pagini (de exemplu, dacă se mai adaugă o pagină de cuprins), va trebui să 
reajustaţi corespunzător compensarea. Aşa că, această compensare este cel mai bine de stabilit 
la finalul cărţii.

Cum faceţi acest lucru.

1) Chiar  în  documentul  master  —nu în  subdocument—plasaţi  cursorul  chiar  deasupra 
câmpului ce conţine numărul de pagină, de pe prima pagină a primului capitol. Daţi clic 
dreapta şi alegeţi Câmpuri (Fields) din meniul contextual.

2) În caseta de dialog Editare câmpuri (Edit Fields) (Imaginea 17), tastaţi un număr par 
negativ  (–2,  –4,  etc.)  în  câmpul  Compensare  (Offset).  Apăsaţi  OK pentru  a  păstra 
modificarea.

Imaginea 17. Folosirea unei compensări pentru a porni de la un alt număr de pagină.

3) S-ar putea să trebuiască făcute nişte modificări pe a doua pagină a primului capitol.
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Includerea  paginilor  «vedere»  într-un document 
master «portret»

Problema

Documentele  master  ignoră  întreruperile  manuale  de  pagină  în  subdocumente  dacă 
întreruperea manuală specifică stilul de pagină care urmează (sună mai degrabă ca o greşeală, 
nu o facilitate). Paginile cu aspect de vedere (landscape) sunt inserate în documente ce folosesc 
orientarea portret inserând o întrerupere de pagină manual şi specificând un stil de pagină cu 
aspect tip vedere (şi  apoi schimbând înapoi  la portret  inserând altă întrerupere manuală şi 
specificând următorul  stil).  Această  tehnică funcţionează până când documentul  devine un 
subdocument dintr-un document master. Din acel moment paginile cu aspect de vedere devin 
cu aspect de portret, iar întreruperea de pagină în sine este ignorată.

Solu iaţ
1) Îndepărtaţi paginile tip vedere din subdocument şi puneţi-le într-un document separat. 

Dacă  paginile  respective  sunt  în  mijlocul  unui  document  portret,  veţi  avea  trei 
documente separate: (a) paginile portret de dinainte de cele vedere, (b) paginile vedere 
şi (c) paginile portret de după cele vedere.

2) Inseraţi documentele (a) şi (c) în mod individual în documentul master.

3) Apoi faceţi una dintre următoarele:

• Inseraţi  o  secţiune  text  în  documentul  master  între  documentele  (a)  şi  (b).  În 
secţiunea text, inseraţi o întrerupere de pagină manuală (specificând stilul de pagină 
cu  aspect  de  vedere),  şi  apoi  copiaţi  conţinutul  documentului  (b)—paginile  tip 
vedere—în  documentul  master.  Dacă  este  necesar,  inseraţi  încă  o  întrerupere 
manuală de pagină (cu un stil de pagina cu aspect portret) înaintea documentului (b). 

sau

• Inseraţi documentul (b) în documentul master ca un subdocument, folosind metoda 
descrisă  la  pagina  10 pentru  a  include  o  întrerupere  manuală  de  pagină  într-o 
secţiune text înainte şi după documentul cu aspect tip vedere.

Orice metodă veţi folosi, va trebui să vă gândiţi la capetele de pagină şi la finalurile de pagină 
din document. Dacă doriţi capete / finaluri de pagină «portret» pe paginile «vedere», folosiţi 
metodele descrise în Ghidul utilizator, la capitolul despre capetele şi finaluri de pagină.
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